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Course Objectives
After this course, you should be able to:
• Logon and off of Oracle Applications
• Use forms and menus
• Enter data using forms
• Search for data using forms
• Run and monitor reports and programs 
• Identify and use the two types of flexfields
• Request Processing
• Set personal user profile options
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Starting Oracle Application
Starting Oracle Applications
To start Oracle Applications, you need to:
• Start up your computer system
• Start your Web Browser
• Start the Oracle Applications program
• Log on to Oracle Applications
• Choose a responsibility (if necessary)
• Navigate to an application window
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Sign-on
You need an Oracle Applications username and password, 
also known as an Oracle Applications sign–on, to log on to 
Oracle Applications. 

It is different from the username and password you use to log 
on to your computer. 

Oracle Applications security is based on your Oracle 
Applications sign–on. 

Your sign–on connects you to your responsibilities, which 
control your access to applications, functions, reports, and 
data.
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Sign-on
Your Sign-on can look as two types : Oracle Applications screen

This is also known as accessing Forms–based applications. Forms–
based responsibilities launch Oracle Applications Forms.
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Sign-on
Oracle Applications connects to  Personal Homepage: page
• This further connects to

• Forms Based Applications
• Self-service Applications
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Choosing Responsibility
If you are an authorized user of Oracle Applications, one of two things 
occurs after you sign on to Oracle Applications:
The Navigate window appears listing your  current responsibility in the 
window title.
A window containing a list of responsibilities appears.
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Oracle Applications: Navigation
Login ( three tabs are visible)
• Functions : Access to Forms 
• Process Navigator : Graphical maps to business processes, to 

automate processes flows  across product boundaries
• Documents ( Customizable Link to documents : PO, Invoices..) 
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Navigator Window
Opening a Form from the 
Navigator Window
• Use the Navigator 

window to navigate to a 
form that lets you 
perform a specific 
business flow. 

• The Navigator window is 
always present during 
your session of Oracle 
Applications and 
displays the name of 
your current 
responsibility in its 
window title.



© Spider Systems Pvt. Ltd.Slide  No. 11

Mastek

Navigator Regions
The Navigator consists of three regions: 
Functions, Documents, and Processes. 
• Functions region provides a list of forms displayed like the files in 

a file system.
• Documents region is a customizable region that allows you to 

create links to specific documents that you use frequently.
• Processes region provides graphical maps of business processes, 

allowing you to automate business flows across forms.
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Navigator
Navigator shows forms you can navigate to and has an 
explorer like structure.

Expand/collapse buttons: 
• Double ++ to expand all the sub-levels
• Single + expands All children sublevels
• Double -- : collapses all sublevels
• Single - : collapses all child sublevels

Most favorites addons : By passing them to righthand list
Choosing a Form: select Open Form or Double Click or Use 
^L to get LOV and then select a specific form.
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Navigator

If there are forms that you use frequently, you can copy them 
over to a navigation top ten list located on the right–hand 
side of the Navigate window. The top ten list displays your 
forms numerically so you can choose them instantly without 
having to search for them in the navigation list.
To open a form from the navigation top ten list:
• Type the top ten list number that precedes the form you want to 

open.
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Switching Responsibility or User
If you have several responsibilities and you want to work in 
Oracle Applications under a different responsibility, you can 
do so without exiting Oracle Applications. 
• Choose Navigator from the Window menu to make the Navigate 

window active then Choose Switch Responsibility from the File 
menu.

• Have a look at other menu options under File main menu. 
• Logon as a different user
• Attention: When you sign on to Oracle Applications as a different 

user, any windows that are currently opened will be automatically 
closed.

• You can change your password using: Choose Change 
Password... from the Edit, Preferences menu, to display the 
Password Update window. 
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Using Forms & Menus
Oracle Applications use a Multiple Document Interface (MDI). 
All windows are displayed inside a single container window, 
with a single toolbar, menu, message line, and status line 
attached to that window.
Pulldown Menu : The pulldown menu bar includes the following
menus:

• File
• Edit
• View
• Folder
• Tools
• Special A & B (only visible when active)
• Window
• Help
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Using Forms & Menus

Use these menus to navigate through a form, to edit or retrieve 
data, or to perform various other actions.
To display a list of keyboard shortcuts:
• Choose Keyboard Help... from the Help menu.
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User Interface
1.   Applications Window
2.   Title Bar
3.   Menu
4.   Toolbar
5.   Window Title
6.   Required Field
7.   Field (display only)
8.   Region Title
9.   Disabled Button
10. Checkbox
11. Region Border
12. Button (enabled)
13. Message Line
14. Status Line
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User Interface

15. Option Group
16. Selected Option
17. Disabled Option
18. Poplist
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User Interface
19. Current Record 

Indicator (If the 
record allows 
drill–down the 
Current Record 
Indicator is 
twice as wide.)

20. Scroll Bar

Message Line: The message line near the bottom of the Oracle 
Applications window displays helpful hints or messages when 
you encounter a minor error.
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User Interface
Drill–Down Indicators

When a record or field provides the drill–down capability, it 
lets you navigate directly to another window that displays 
details of the current record or field, or information related to 
the current record or field.

Records that provide drill–down are indicated by a wide width 
current record indicator. By double–clicking on the indicator 
you will navigate to the detail window.
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Tool Bar
The toolbar is a 
collection of iconic 
buttons, where each 
button performs a 
specific action when 
you choose it. 
Each toolbar button 
replicates a commonly–
used menu item. 
Depending on the 
context of the current 
field or window, a 
toolbar button can be 
enabled or disabled.

New - Opens a new record in the active form

Find – Displays the Find window to retrieve records.

Show Navigator – Displays the Navigator window.

Save – Saves any pending changes in the active form

Next Step – Updates the Process workflow in the Navigator 
by advancing to the next step in the process.

Print – Prints the current screen that the cursor is in. In some 
cases it may print a report associated with the current data. 
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Entering Data
Clearing Data
Simple data entry features & ability to cut, paste, copy and 
dulpicate record are available.
You can clear data from the screen at almost any time. The 
data you clear is simply erased from the screen and not 
deleted from your database.

• Choose Clear, Field  or Record, Block or Form  from the Edit menu.
• This is useful when user wants to start a Query but actually enters 

data in normal entry mode. 
Learning About a Record

• You can always display information about a record that has been 
saved before. The information includes who created the record, the 
date of creation, and the database table where the record resides.

• Choose Record History from the Help menu.
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Navigation ( 1 of 3)

Form Fields Color
• White with green underline text: Supports Drill down
• Yellow field require data entry
• Blue: Fields to use in query enter mode
• Region : Logically related fields,  enclosed by a rectangular box. 

Current Active Record:
• One character filled on left side in a multi record block
• If the current record has two character wide fields then it supports 

drill down.
Status Line: 
• Number of records.. and Message Line: Helpful hints
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Navigation ( 2 of 3)

Other basics
• Combinations Block : Supports both MultiRecord and Single record format. 

This can be done by selecting Summary/Detail from View menu.
Query
• Query Navigation  if large number of records: Use View > Record > Last gets 

the 100th record then ask if to continue
Export:  
• From the File Menu, to export Multirecord  data into tabbed delimited file use 

query find and the export .
• Use the Export feature to export records in a multi–row block to a tabbed–

delimited file which you can open in the application of your choice. Export 
always uses the records and format currently queried in the form. Thus, you 
can control the data to be exported using the query functions of the form, 
such as Query Find.
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Navigation ( 3 of 3)

To Select Multiple Records for some actions use the Ctrl Key, 
hold it down and select by clicking on each record.

Folder Block: 
• A special block where user can customize field and record layout.  

Can be recognized by Folder icon in the block and folder tools in 
tool bar. 

• Folder allows user to select fields to be displayed, prompts, width, 
sequence, Order and specific criteria for subset of records. This 
folder can be saved to use later for later use again. 
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Flexfields
A flexfield is a flexible data field that your organization can 
customize to your business needs without programming. 

Oracle Applications uses two types of flexfields, key
flexfields and descriptive flexfields. 
• A key flexfield is a field you can customize to enter multi–segment 

values such as part numbers, account numbers, and so on. 
• A descriptive flexfield is a field you customize to enter additional 

information for which your Oracle Applications product has not 
already provided a field.
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Key flexfields
A key flexfield is a field made up of segments, where each 
segment has both a value and a meaning. 
You can think of a key flexfield as an “intelligent” field that 
your business can use to store information represented as 
“codes.”
Most organizations use “codes” to identify general ledger 
accounts, part numbers, and other business entities. 
Each segment in the code represents a characteristic of the 
entity.
A key flexfield is flexible enough to let you use any code 
scheme you want to describe an entity.
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Descriptive Flexfield
A descriptive flexfield gives you room to expand your forms, since 
Oracle Applications cannot predict all the possible information you 
may want to track. 
Your organization can use descriptive flexfields to capture 
additional information that is important and unique to your 
business.
A descriptive flexfield appears in a block as a two character, 
unnamed field enclosed in brackets.
A descriptive flexfield window appears when you move your cursor 
into a customized descriptive flexfield.
Each segment in a descriptive flexfield window has a name, and can 
have a set of valid values. Your organization can define 
dependencies among the segments or customize a descriptive
flexfield to display context–sensitive segments, so that different 
segments appear depending on the values you enter in other fields 
or segments.
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Entering Data into Flexfield
Descriptive Flexfield Window
• Move your cursor into a customized descriptive flexfield to display 

the flexfield window.
• When the window appears, the cursor moves to the first segment 

that does not contain a default value.
• Enter a value in each segment.
• Depending on how your organization customizes a descriptive

flexfield, you can either type a value into a segment, or if the 
<List> lamp appears on the status line for a particular segment,
you can display a list of values to choose from for that segment.
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Key Flexfield
To enter a known combination into a key flexfield:
• Move your cursor into the key flexfield.
• If you know the exact combination of segment values you want, 

enter the concatenated combination directly into the key flexfield
To display a list of existing combinations:
• Move your cursor into the key flexfield.
• Choose the List of Values icon to open the Flexfield window.
• Choose Combinations in the flexfield window to display the 

existing combinations.
• If there are several combinations you may be asked to enter 

values for the segments to shorten the list. 
• To see all combinations enter ’%’ in one of the segment fields and 

choose OK.
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Reports & Programs
Every Oracle Applications product contains reports and 
programs that are specific to that product. 
A report generates a summary or detail presentation of 
Oracle Applications information, whereas a program can 
perform a function. 
The reports and programs you have access to are defined by 
the responsibility you use.
Oracle Applications provides two features called 
• Concurrent processing and Standard Request Submission to help 

you run the reports and programs that are a part of your 
responsibility.
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Running Reports & Programs 
Running Oracle Applications Reports and Programs
• Concurrent Processing implies ability to run non-interactive, data 

dependent function such as a report or program simultaneously 
with online operations 

• With concurrent processing, you can complete non–interactive 
tasks without interfering with the interactive work you perform at 
your computer.

• Standard request submission works with concurrent processing 
and provides a common interface for running Oracle applications 
reports and programs 

• Oracle Applications runs all of its reports and programs as 
concurrent processes.
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Request set
Request Set
• Request set is a collection of report/programs   that you group 

together and can be submitted to run is a single interaction
• The concurrent requests are run and monitored  by a concurrent 

manager .
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Some Definitions
Concurrent Program
• A concurrent program is a program that does not require 

continued interaction on your part to perform a specific task. 

Concurrent Request
• A concurrent request is a request that you submit to run a 

concurrent program as a concurrent process. You issue a 
concurrent request when you submit a report or program to run 
using Standard Request submission.
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Concurrent Processing
Concurrent Manager
• A concurrent manager is a component of concurrent processing 

that monitors and runs tasks without tying up your computer.

Concurrent Processing Options
• you control and change the number of copies to print, what print

style to use, and which printer to use
• you can also choose to hold a request from being run, choose a 

specific date or time to start a request
• choose to save the results of your concurrent request in a 

standard file format.
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Concurrent Processing 
Online Request Review
• You can review the output and log files from your concurrent 

requests online. 
• You can see the results of a concurrent request without the delay 

of printing out the entire report or log file.
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Concurrent Processing 
Scheduling
• Using Standard Request Submission, you can define schedules to 

automatically resubmit your program, report, or request set. At 
submission time, you can specify: 

• starting date and time
• the time of day for resubmission
• the resubmission interval in months, days, hours, or minutes from 

either the start or completion of the request
• the date and time to stop repeating the program, report, or request 

set day or days of the week or month to resubmit

• Oracle Applications automatically resubmits the program, report,
or request set until the end date.
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Standard Request Submission
Standard Request Submission provides you with a set of 
windows for running reports and programs and a set of 
windows for creating groups of reports and programs to run 
together. 

These windows give you control over the submission and 
output of your reports and programs.
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Standard Request Submission- Features
Use a standard interface to run your programs and reports. 
• Control access to different programs and reports.
• Pass parameters from your environment to your reports and 

programs.
• View report output online.
• Create and run sets of reports and programs.
• Automatically run programs, reports, or request sets at specific

time intervals.
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SRS-Features
• Specify whether reports and programs in a request set run 

sequentially or simultaneously.

• Specify whether to continue with a request set if a report or 
program in a sequential set fails.

• Specify alternative requests to run based on the completion status 
of previously run requests in a request set.

• View a log file that summarizes the completion information about
all the reports and programs in a request set.
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Submitting a request
There are three elements to submitting a request. Selecting 
the request or request set to be submitted, defining a 
submission schedule, and providing completion options.
• Selecting the request or request set may require you to provide 

request parameters and the output language.

• Defining a schedule can be as simple as submitting as soon as 
possible or using a more complex schedule that you define when 
you first submit your request and may be used for other requests
in the future.

• Completion options allow you to deliver request output to others
and specify which printers and how many copies of the output you
want to produce for each request.
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Request submission

To submit a request:
1. Navigate to the Submit a New 

Request window (Other –> Requests 
–> Run).

2. Check the Request option to submit 
single requests, or choose to submit a 
predefined group of requests by 
checking Request Set.

3. Choose OK.
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Request Submission
Submitting requests

4. Use the Copy...button to take advantage of 
previously entered
request submissions.

5. Select the Name of the request (report or 
program) you want to run from the list of 
available requests.
Note: Your responsibility’s request group 
determines which requests appear in the list.
Defining Parameters

6. A Parameters window automatically appears if 
you select a request
that requires parameter values and your profile 
Flexfields:Open Descr Window is set to Yes.
Choose a type of schedule from the following: 

• As Soon as possible, 
• Once: Submits your request once at the time and 

date you specify.
• Periodically
• On Specific Days ( of week or month)



© Spider Systems Pvt. Ltd.Slide  No. 44

Mastek

Monitor & View Request
Use the Find Requests window

Use the Requests window

View the progress of a concurrent request

Cancel a request or change its processing options
• Since all reports, programs, and request sets are run as 

concurrent requests in Oracle Applications, you use the 
Requests window to view the status and output of your requests.
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Requests Window
When submit a request Oracle Applications assigns a request 
ID to the request. You can use this Request Id to search for 
your request.
You can use the Requests window to view 
• a list of all submitted concurrent requests
• check whether your request has run
• Change aspects of a request’s processing options, diagnose 

errors, 
• find the position of your request in the queues of available 

concurrent managers
Navigating to View Requests
• Use Find Requests window from the Navigator menu

Checking detailed status and Output, Log etc.
• Navigate to your request and use buttons to display as needed
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View Output & Log
To View Request 
Output: Choose 
View Output

To view requests 
log files: Choose 
View Log to 
display the 
request’s error log 
file.
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Monitoring Requests
Monitoring Requests
• Oracle Applications lets you monitor your concurrent requests 

when you display the Requests window. And, if your request has 
not yet started running, Oracle Applications lets you cancel or 
change some of the request’s parameter, scheduling, or 
completion options.

Concurrent Request Phase and Status
• The Requests window displays a phase and status summary for 

each concurrent request listed.
• A concurrent request has a life cycle consisting of the following 

phases: pending, running, completed, and inactive.
• During each phase, a concurrent request has a specific condition

or status.
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Monitoring Request
Generally the first phase set for a request is “Pending”.

A chid request is waiting for its Parent request to mark it 
ready to run. For example, a request in a request set that 
runs sequentially must wait for a prior request to 
complete.

Waiting

Request is scheduled to start at a future time or date.Scheduled

Program to run request is incompatible with other 
program(s) currently running

Standby

Request is waiting for the next available manager.NormalPENDING

Phase                    Status              Description

Request is terminated by choosing the Cancel Request
button in Requests window.

Terminating

All requests submitted by the same parent request have 
completed running. The Parent request resumes running.

Resuming

Parent request pauses for all its child requests to finish 
running. For example, a request set pauses for all requests 
in the set to complete.

Paused

Request is running normally.NormalRUNNING
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Monitoring

Request is terminated by choosing the Cancel Request 
button in the Requests window.

Terminated

Pending or Inactive request is cancelled by choosing the 
Cancel Request button in the Requests window.

Cancelled

Request completed with warnings. For example, a request 
is generated successfully but fails to print.

Warning

Request failed to complete successfully.Error

Request completed successfully.NormalCOMPLETED

Phase                    Status              Description

No manager is defined to run the request. Check with your 
system administrator. A status of No Manager is also given 
when all managers are locked by the run-alone requests.

No Manager

Pending request is placed on hold by choosing the Hold 
Request button in the Requests window.

On Hold

Program to run request is not enabled. Contact your 
system administrator.

DisabledINACTIVE
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Canceling Request 
Use the Requests window to cancel a request (report, 
program, or request set) that has not yet completed.

To cancel a request that has not yet completed:
• Navigate to the Find Requests window.
• Check My Requests in Progress.
• Choose Find.

With your cursor on the request you wish to cancel, choose 
Cancel Request to terminate the request. 
You can only cancel a request if it is in the Running, Pending, 
or Inactive phase. 
You can put your request on hold by choosing Hold Request 
if the request is Pending  or Inactive.
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Request
If you terminate a request while it is in the Running phase, 
the current run stops,  but the resubmission does not. 

While the resubmitted request is in the Pending phase
• you can go to the Resubmission tabbed region of the Requests 

window and change the Interval for the request to 0 or change 
the End Date to a date that has passed to cancel the 
resubmission.

Changing Request Options
• If your request or request set has not started running, you can 

change how your request or request set runs and prints its 
output using the Requests window.
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Understanding User Profiles
Oracle Applications user profiles help you satisfy the 
following business needs. 
• Set options that affect your application’s behavior to your 

preference
• Modify product–specific variables that affect the functionality of 

your application to suit your business environment
• User profiles give you control over the behavior of certain Oracle 

Applications features.
• A user profile is a collection of changeable options that affect the 

way your applications run. 
• Oracle Applications establishes a value for each option in a user’s 

profile when the user logs on or changes responsibility. 
• Oracle Applications provides these options so that you can alter

the behavior of your applications to suit your own preferences.
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User Profiles

Oracle Applications uses a set of user profile options 
• Are common to all the application products. 
• Each application product has its own unique set of user profile 

options. 
• The reference guide for your application contains a complete list and 

a description of each user profile option that is specific to your 
application.

• User profile options can be set at one or more of four levels:  
Site, Application, Responsibility, and User. 

• Your system administrator can set default option values at any of 
these levels.
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User Profiles Levels

User Profile Hierarchy
Oracle Applications treats user profile levels as a hierarchy, where 
User is the highest level of the hierarchy, followed by 
Responsibility, Application, and at the lowest level, Site.

Site Level : 
• Site is the lowest profile level. Site–level option values affect the way 

all applications run at a given installation site.

Application Level: 
• Application is the profile level immediately above Site. Application–

level option values affect the way a given application runs.
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User Profiles Level

Responsibility Level : 
• Responsibility is the profile level immediately above 

Application. Responsibility–level option values affect the way 
applications run for all users of a given responsibility.

User Level: 
• User is the highest profile level and is immediately above 

Responsibility. User–level option values affect the way 
applications run for a given application user.
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User Profile
Your system administrator can set values for user profile options at 
each profile level.

• Typically, your system administrator sets Site–level option values after 
installing Oracle Applications at a site. 

• These Site–level option values apply until you or your system administrator
changes them.

• Oracle Applications derives a run–time value for each user’s profile option
based on the value set at the highest hierarchy level.

• Any change your system administrator makes to your profile options   takes
effect as soon as you log on again or change responsibilities.

• You can set your own preference at the User–level, since your User–level 
setting overrides the Responsibility–level setting.

• Some option values can only be changed by the system administrator.
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User Profiles : Examples 
Edit menu is used to open profiles window. Checkout some 
of these examples
• Attachment File upload directory : This Provides the directory path 

used to upload attachment files.
• Set of Books Name : Provides access to specific Set of Books in GL
• MO Operating Unit :  This allows user to specify operating unit
• Sign-on Notification : Messages about failed concurrent programs 

or failed logins
• Viewer: To set up Browser for viewing the documents.
• Default Country : This is the default source for the Country field for 

all address zones and is used by the Flexible Address Formats 
feature, the Flexible Bank Structures feature and the Tax Registration 
Number and Taxpayer ID validation routines.

• Flexfields:Open Descr Window: You can control whether a 
descriptive flexfield window automatically opens when you navigate 
to a customized descriptive flexfield.
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